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From The Chief Editor's Desk
So much for the hopes that 2017 would be kinder to our celebrities. They seem to be leaving us just as fast as they did in 2016. If you recall, last month I ran a rather extensive list of celebrities and notable people we lost in 2016. So far, in January of this year, we've lost quite a few other celebrities and notable people. 2017 seems to be starting off to keep 2016's unrelenting pace for the extraordinary rate that our celebrities and notable people left us.
So far this year, in just January alone, we've lost these 25 people. At this pace, we could see nearly 300 celebrities and notable people leave our presence.

As the deaths of celebrities and notable people around us continue to mount, it serves merely as a reminder of the frailty and finality of life. My only solace is that I'm not having to write about another PCLinuxOS user that has left us. As the chief editor of the magazine that serves PCLinuxOS users, it's admittedly one of the most difficult duties that I have. I certainly hope that I'm not having to write any such articles any time soon, as inevitable as the task may be.
So, until next month, I bid you peace, happiness, serenity and prosperity ... and good health.



LibreOffice 5.3: New Version, New Changes Coming
by Meemaw
LibreOffice updated a while back and gave us a couple of different formatting options as far as tools. One is a different toolbar, called the Standard (Single Mode). It is a configurable toolbar that only takes up one line at the top of your window. I like it because I can put only the absolute essential tools at the top and can still always find everything. Lately, however, I have also been using the Sidebar, which can be opened and closed at the right side of the window.
On January 3rd, The Document Foundation -- who oversees LibreOffice -- announced that they had a beta test of the newest update to the popular office suite. For those people who really like MS Office's "Ribbon" interface, LibreOffice has created their version of it, and the newest update, 5.3, will contain the new feature. Now you will be able to use whatever tool option you wish. However, instead of forcing any one option on you, you will be able to choose the tools you want. Your choices are:
The Notebookbar is the new one. You have eight tabs:









What I saw from the beta version is that there is still a bit of trouble with the icons in each tab (some are missing). Also, there are some icons missing from their respective text labels. I had an earlier beta on my Win7 computer (January 4th or so) and some of the missing icons have shown up on this beta on my home laptop (January 15th). What is annoying to me is that the icons are there, but returning to that tab later, the icons may have been replaced with down arrows. You can hover your mouse over them and the items will be described in the tooltips.
Bear in mind that this is the Beta version and that all these will be remedied before they release the 5.3 version.
You can install it and try it yourself. NOTE: The standard warning applies for installing programs outside our repository. Since this is a beta and hasn't been tested by our programmers, there's no guarantee that it won't adversely affect your system.
To try it yourself, the first thing you must do is download the beta release of 5.3 (you'll have to choose the correct package section for your system, then click the "current" folder to find the newest RPM package and the help package) and save it in ~/Downloads. Once you have that downloaded, follow these steps:
When the command completes, there will be a new series of LibreOfficeDev 5.3 entries in your Office menu, and you can start it from your menu.
Before you can use it, you have to enable it. Starting LibreOffice the first time, the new toolbar feature isn't enabled. To do this, click Tools > Options. Under LibreOfficeDev, click on Advanced and then click the check box associated with Enable experimental features. Click OK and then you will be prompted to restart LibreOffice.

When it restarts, go to View > Toolbar Layout and select which toolbar you want to use.

Choose it, and you can test the Notebookbar toolbar layout coming in the official 5.3 release.
I will probably continue to use the single mode toolbar and sidebar. I never cared for the "ribbon" (which is one reason why I go out of my way NOT to use MS Office), and while I do think this is a good advance for LibreOffice, it's something that I don't care for. Hey, we're all about choice, right? I think it's also about your personal equipment as well. Some of these configurations are better for an older 1024 x 768 monitor, while others work great on the newer, wider laptop monitors.
Anyway, this is just a summary of things to come. We'll have another review when LibreOffice 5.3 has been released and is in the PCLinuxOS Repository. By then, the LibreOffice testers should have all the "bugs" worked out and it should be functioning well.
UPDATE: The Document Foundation has announced the new MUFFIN. This is an acronym for My User Friendly & Flexible INterface. This is their name for the group of toolbar types that have been described above. This includes all the different toolbar styles a user might want to select, including the Notebookbar that is very "ribbon-esque" in appearance and functionality.
Also, February 1, 2017 is the scheduled release date for LibreOffice 5.3, so be on the lookout for this newest version of LibreOffice to hit the PCLinuxOS repos soon thereafter. Puzzlingly, there was a release of LibreOffice 5.2.5 with only about a week to go until the official release of 5.3. It contains only a couple of bug fixes, so it's a bit odd to release the 5.2.5 version so close to the official release of 5.3.

De-Google Yourself ... Sorta
by Paul Arnote (parnote)
You either love "them," or you love to hate "them." There really doesn't seem to be much middle ground.
"Them" is Google. They are literally everywhere. In a lot of ways, it's difficult to avoid bumping into "them" on the ‘net. Besides running the premiere search engine on the internet, they also run Gmail, Google Docs, Google Maps, Google News, Google Translate, YouTube, Google+, the Google Play store, Google Docs, Google Drive, Google Photos, Google Hangouts, Google Voice, Google Wallet, Blogger, etc. The list is ever expanding, as Larry and Sergei expand their empire.
If you think that Google is all of these services, you'd be 100% wrong. What a lot of people don't realize is that Google gets its income from 1) selling advertising, and 2) collecting information about YOU, that it sells to just about anyone willing to pay for it. That information includes your likes and dislikes, who you email and how often, who you receive email from, what websites you visit, what things you search for, what you buy, what videos you watch, and sometimes even what you watch on TV, or who you talk to on the telephone. The more services it controls, the more of your personal information Google can access about you. "Do no evil," Google's one-time credo, died a painful death long ago.
Regardless of how you feel about Google, everyone has used their services at one time or another. Even if you avoid their services now (which is difficult), you have most likely used their services in the past.

So what if you could erase your Google tracks, so to speak? Well, at least that is the premise of Google My Activity. Data collection has become the currency of the 21st Century. With every three and four letter government agency, governments and businesses collecting information on virtually every online user, most savvy users these days are always seeking to lessen their digital footprint. There has even been speculation and accusations about Google being tucked tightly into bed with those three and four letter government agencies across the globe.
The default view is called "Bundle view," and is what is depicted in the screenshot above. The alternative view is "Item view," and you can select it (second item) on the left side of the screen.

The third item down on the left side of the screen is "Delete activity by." The screenshot above shows the default screen you will see in your browser. Clicking on the "Delete by date" dropdown allows you to select your activity Today (default), for the last seven days, for the last 30 days, or all of your activity. The product category dropdown allows you to select which history data you want to delete for select Google products, or if you want to delete your history with all products (default).

Selecting on the "Try This" link in the top of the box will give you even more options. Click on the "+" sign at the top of the screen. Then, you can set a custom date range for the history you want to delete, under the "Filter by date" selection field. The default selections (except for the date range) are shown on the left, which is to delete the history for all Google products. Deselecting "All products" allows you to select only the Google products you want to delete your history from. For example, you might want to keep your Google+ history, your Google Play Store history, and your YouTube history. In that case, just make sure those Google products are not selected, as in the image on the right.

Back on the "main" screen for My History, the third item down on the left in the menu is to control "other" Google activity. You will be presented with a list of "other" Google activities. For example, clicking on "visit timeline" under "Location History" shows me all of the data that Google (and Google Maps) has collected about where I go. It may be shocking to many just how much information Google collects on you.
Surprisingly, clicking on "Device Information" "visit activity" shows nothing, for me anyways. I'm very surprised, since I have an Android phone. Most likely, the reason is that I have "Device Information" paused in my Google account settings. That is at least partial verification that this setting somewhat works. However, I did find a lot of information from my Android cell phone listed in the "Location History," meaning that there are leaks and crossovers in the way Google stores data about you. So, if you are wanting to eliminate a larger chunk of your Google digital footprint, it would behoove you to carefully check out all of the sections, since you're never completely sure under which category Google will choose to save your data.

One area a lot of users are going to be interested in is the "Activity controls." This allows you to completely turn off (pause) collection of your history in many of the Google products you might visit. The areas are "Web & App Activity," "Location History," "Device Information," "Voice & Audio Activity," "YouTube Search History," and "YouTube Watch History." There are additional links at the bottom to allow you to customize your settings for Google+, shared endorsements, search settings, and ads.

Selecting "My Account" from the menu on the left side of the screen opens another window that allows you to tweak many settings associated with your Google account. One handy feature here is the "Find your phone" feature. This allows you to locate or ring your phone. It also allows you to remotely lock your phone so it cannot be accessed. If all else fails, it allows you to remotely erase your phone to prevent your private data from falling into sinister hands.

When you choose "Find Your Phone," you'll see a list of all the phones and tablets that are registered with your Google account. Select the device you want to locate.

Selecting a device (I selected my current cell phone, the LG V20), you will then be given a menu of options to perform on that device. The items listed should be fairly self explanatory.
Be sure to explore all of the "My Account" settings. You are likely to find things that you never imagined were user controllable. Depending on your situation, all of these items can help to minimize your Google digital footprint. Since every person's situation is going to be different, I won't go over all of those settings here. To do so might necessitate a book, rather than a magazine article. The vast majority of the account settings are reversible, so if you make a change to a setting, it's a relatively simple task to change it back if the change isn't working well for your situation.
Summary
The preceding information should give you an idea of the breadth of information collected by Google. In many ways, it's mind boggling. So you might be asking, "how long does Google keep its server logs?" The answer to that is indefinitely. Translate that into forever. After nine months, Google deletes a portion of your logged IP address. After 18 months, Google anonymizes cookie IDs that can be associated with your computer or device.
Deleting your trail of activity on Google products can certainly go a long way to minimizing your overall digital footprint. The same can be said for controlling the information that is collected via the "Activity controls." However, if your information has already been vacuumed up by the three and four letter government agencies, governments or businesses, you will only be erasing information collected by Google. These controls will have no effect on that information that was already pilfered and collected by third parties. That data (the three and four letter government agencies call it "metadata") is forever in their possession, and you're more likely to be struck by lightning than them giving up access and possession of that data.
I find it odd that online information is subjected to less privacy than snail mail. In many jurisdictions, it's illegal for ANYONE to intercept and read snail mail without a warrant issued by a court of law. That "anyone" includes governments, government agencies, and everyone else. With all the data that is streaming around, encrypted or not, I suspect it's just too much of a temptation to take a peek. It reminds me of just dying to see what's behind that closed door at the end of the hallway, or the contents of a Christmas present under the tree.
I'm reminded of a very wise saying: "just because you can, doesn't mean you should." Since many don't understand this maxim, it's up to you to minimize the amount of YOUR information that is available to them.


ms_meme's Nook: Love Letter To PCLinuxOS
PCLinuxOS Recipe Corner: Pastalaya
Pastalaya
Ingredients:
1 Tbsp vegetable oil
1/2 lb. smoked sausage (preferably Andouille)
2 cloves garlic, minced
1 10 oz. bag frozen "seasoning mix"*
1 15 oz. can diced tomatoes
1/2 Tbsp Creole seasoning**
1/2 tsp oregano
1/2 tsp smoked paprika
1/4 tsp thyme
Freshly cracked pepper to taste
2 cups chicken broth
1 cup water
1 lb. penne pasta
2 Tbsp half & half or cream
1/2 bunch fresh parsley
1/2 bunch green onions
Instructions:
Slice the smoked sausage into thin rounds, then cut any larger pieces in half. Add the sausage and vegetable oil to a large pot and cook over medium heat until the sausage is well browned (about 5 minutes).
Mince two cloves of garlic and add them to the pot. Sauté' for one to two minutes, or until the garlic is soft and fragrant. Add the bag of frozen seasoning mix and sauté until heated through (3-5 minutes). Finally, add the can of diced tomatoes (with juices), Creole seasoning, oregano, smoked paprika, thyme, freshly cracked pepper (about 20 cranks of a pepper mill), chicken broth, 1 cup of water, and pasta to the pot. Stir until everything is evenly combined.
Place a lid on the pot and turn the heat up to medium-high. Let the pot come to a boil. As soon as it reaches a boil, remove the lid briefly to stir, then replace the lid, turn the heat down to low, and let the pot simmer for 12-15 minutes, or until the pasta is tender. Stir the pot once every few minutes as it simmers to prevent the pasta from sticking. Replace the lid as quickly as possible after stirring to avoid heat loss.
While the pasta is simmering, pull the parsley leaves from the stems and give them a good chop, and slice the green onions. Once the pasta is tender, most of the liquid in the pot should be absorbed. If it's still a bit soupy, let the pot simmer for one to two minutes without the lid to allow some moisture to evaporate.
Turn off the heat and stir in the half & half or cream. Stir in most of the chopped parsley and green onions, reserving some to sprinkle over top. Serve hot with a pinch of fresh parsley and green onions on top of each bowl.
Notes
* The "seasoning mix" used is a pre-chopped and frozen blend of onion, bell pepper, and celery, also known as "trinity". If you prefer to use fresh, chop one yellow onion, one green bell pepper, and two stalks of celery.
** Creole seasoning can be found in most major grocery stores, but you can make your own using the recipe below. Store bought Creole seasoning blends usually contain a lot of salt, so if you make your own, you may need to add extra salt to the final product to compensate.
Creole Seasoning Mix
2 1/2 tablespoons paprika.
2 tablespoons salt.
2 tablespoons garlic powder.
1 tablespoon onion powder.
1 tablespoon black pepper.
1 tablespoon cayenne pepper.
1 tablespoon dried leaf oregano.
1 tablespoon dried leaf thyme

Game Zone: Nation Red
by daiashi

About The Game
Nation Red is an ultra fast, infinite play arena-based shooter providing an exceptional close-quarter battlefield experience. Fight thousands of zombie mutants and their bosses in frantic, bloody gameplay while earning close to 100 perks. Fight in Barricade, Survival or Free Play mode. Play Online in co-op, in single player or in local co-op!
August 17, 1977: Scattered groups of zombies infiltrate remote Midwestern towns. Incapable of using tools or weapons, the invaders are resisted until they retreat back into the desert. Special elimination posses are set up to hunt down any of the surviving undead. Six weeks after the squads started their search-and-destroy mission, the last known zombie was shot and killed.
Present-day: Over thirty years had passed when a truck driver traveling down a desolate Arizona road plows into a wall of undead. Before the driver's phone signal went dead, he reported some were carrying guns. They're back, and now they are hunting us. This is a great game. The graphics are similar to Borderlands, but include top down views and zombies.
Steam Exclusive Features:
Features:
System requirements:
Fully updated PCLinuxOS and Steam
Hardware:
About The Company
DiezelPower Studios is the internal developer of KaosControl, with development studios in Nice, San Francisco, and Yokohama. Not much else could be found about the developers.
Some Gameplay Screenshots





Getting It To Run
Install Steam (if you don't have it installed already), then start it. You will need to create a new account, if you do not already have one. Once you have Steam up and running, go to the store tab. Click on the Linux tab if you wish and search for Nation Red. This one has no demo. If you have updated your system, including graphics drivers, you should be good to go.
Inkscape Tutorial: Create Tiled Clones, Part One
by Meemaw
The Clone tool in Inkscape is useful for creating many copies of a single object. It is convenient to clone an object rather than to simply copy one. If you make several copies of an object, then they are all stacked up in one group and must be moved. Also, clones are unique in that if you change the beginning object, the change also happens to the clones. This may make for easier work. The section Create Tiled Clones is very useful for creating many clones arranged a particular way. It is a menu option that has multiple configurations. The configuration window has tabs for several different types of changes. Let's try a few.
Create a simple object, like a circle, square or star. I got a little silly with my star.

Select your object, then choose Edit > Clone > Create Tiled Clones. The configuration window will open, and you can see the tabs at the top. There are only six tabs, but there are loads of changeable options which can create many effects. The one thing common to all tabs is that the bottom never changes. Everything below the line "Apply to tiled clones" remains throughout your tab choices.

If you choose P1: Simple translation, 4 rows and 4 columns, and click Create, you will see an array like the one below:

If you tried this with a square, you probably noticed that your clones were sitting up against each other in a sort of checkerboard pattern. In fact, you can make a checkerboard pattern in just this manner.
What if we don't want everything jammed together? Some of our tabs could remedy this. Let's look at the tabs for a moment. We'll do a few basic things, but honestly, there is so much you can do with the Clones window, it will take more than one article.
Symmetry: This tab lets you choose what to do with the figure you have drawn. The dropdown has 17 choices that alter the clones with a regular pattern. P1: Simple translation makes the pattern that you see above. Some of the other choices can give you a different effect. PMM: reflection + reflection gives you a different pattern, each "star" being a reflection of the one to the left of it, and the pattern continued down and across.

This one is P4M: 90o reflection + 45o rotation

As you can see, there are many choices just using the first tab. You can also click on the Remove button at the bottom to delete your clones and go back to the beginning star. Let's experiment more.
Shift: These settings will let you move things so they aren't just crammed up against each other, or even on top of each other, as in the last example. You can shift, or move, each successive row and column by a certain percent, or randomize each. Click on this tab, and change the settings as you see them below, then click Create.

This will be similar to your result:

If we add 25% to the settings in the Randomize column, we will get this:

Randomize varies the results of the other settings so things aren't symmetrical.
Any of these settings can be changed to any percent. Experimentation is the key in this project! So let's experiment more. Change randomize back to zero, but leave the shift settings as they are.
Scale: This setting will let us change the sizes of our clones. Put in the following settings:

This will have the effect of increasing the height and decreasing the width of each clone in the first row, but decreasing the height and increasing the width in each column. That probably is hard to visualize, so look how we end up:

We probably want to reset those settings. However, we'll keep experimenting. For the next setting, I pressed Reset in the lower left of the window, then went back and set the Shift tab back to the 25% we started with, so that our result will be more easily seen.
Rotation: This setting does exactly what you think: rotates your clones. Set each to 30% as shown below. See the results below that.


Obviously, each clone is at a different angle. You should be able to tell on these that each result as we move to the right and down is a progressive product of the item to the left and/or above it. What I mean by that is that one the first row, the second star has resulted from a 30o rotation of the first, then the third is the second one rotated 30o, so when you get to the fourth, the rotation is much more evident: in fact, it is a 90o rotation of the first.
Blur & Opacity: This setting makes the opacity and blur of your clones different (just what you thought). In this one, I changed my star to a 6-pointed star, with black fill. I also changed the rows and columns to 8 rather than 4. I used a 25% randomize in each setting. You can see what the result is below.

Notice that some are blurrier than others and some are more opaque. You can do these separately as well.
Color: This setting changes the hue, saturation and lightness of the original, so if you need some colors to be different, you can do that as well. Make sure you click on the color chip in the settings window and choose the correct color.


It might be difficult to see, but the stars aren't all the same color intensity. Some are lighter than others.
Let's stop here so you can experiment on your own. Stay tuned for the next article. I'll show you some uses for this tool that you may have already seen.




Give Your Filesystem & Hard Drive Some Love
by Paul Arnote (parnote)
These days, most of us have thousands of photos and documents stored on our computer's hard drive. As much as we've all heard it, preached to over and over again, most of us are less than diligent about backing up our data -- if we even do it at all. That ol' "it'll never happen to me" attitude tends to rule the day.
One of the most vital parts of your computer -- your hard drive and the file system on it that keeps your data organized and accessible -- probably receives the least amount of attention from users. That is, until something goes wrong. That "something" can involve your file system, and when something does go awry with the file system, panic strikes most users like a lightning bolt out of the sky. So, checking up on and keeping tabs on what's happening with your file system has the potential to save you a LOT of extra worries and headaches down the road. Plus, it can save your precious data from being corrupted -- or worse -- lost forever.
Fortunately, Linux comes with some very useful utilities for helping to ensure the integrity of the data stored in your file system. The easiest way to use them is from the command line in a terminal session. The main commands we're going to be using (in no particular order) are fsck, tune2fs, touch, mount, umount and fdisk. Most of these commands will need to be run as the root user.
fdisk
Before we can use the other commands, we first need to know how the operating system sees the various hard drives on our computer. To do that, we issue the fdisk -l command (that's a lowercase L). It is installed by default in PCLinuxOS, so you have nothing else to install from Synaptic. There will be quite a bit of output, but what we're really interested in is the last part. Below is the output from one of my computers.
Disk /dev/sda: 232.9 GiB, 250059350016 bytes, 488397168 sectors
Units: sectors of 1 * 512 = 512 bytes
Sector size (logical/physical): 512 bytes / 512 bytes
I/O size (minimum/optimal): 512 bytes / 512 bytes
Disklabel type: dos
Disk identifier: 0xa33411ea
Device Boot Start End Sectors Size Id Type
/dev/sda1 * 63 8177084 8177022 3.9G 82 Linux swap / Solaris
/dev/sda2 8177085 488392064 480214980 229G 5 Extended
/dev/sda5 8177148 52002404 43825257 20.9G 83 Linux
/dev/sda6 52002468 488392064 436389597 208.1G 83 Linux
Looking at the output, /dev/sda5 is my root partition, and /dev/sda6 is my /home partition. Write these down for handy reference to use with the other commands.
There are a lot more uses for fdisk. You can view the fdisk Linux man page here.
tune2fs
tune2fs allows users to set or adjust tunable filesystem parameters for ext2, ext3 and ext4 filesystems. We'll use a couple of different command line switches to help us achieve our goal of managing the filesystem. You can find a whole list of available command line switches, complete with explanations, by viewing the tune2fs Linux man page here. It is installed by default in PCLinuxOS, so you have nothing else to install from Synaptic.
First, we need to issue the tune2fs -l command (that's a lowercase L, for list), followed by the hard drive partition we want information on. Below is the output from running the command on my /home partition, a.k.a. /dev/sda6. Use the information gleaned from running fdisk -l on your computer, and replace my use of /dev/sda6 with the drive partition from your computer, as reported by fdisk.

For readability, I've highlighted some of the information I'm particularly interested in with red text. Early on in the listing, you'll find the "Filesystem state" information. On this particular hard drive, the filesystem is listed as "clean." A bit further down in the information displayed by the tune2fs command is some important information about the mounting and checking of that particular hard drive and filesystem.
The data shows that my /home partition has been mounted eight times since the last filesystem check (this particular computer tends to stay turned on 24/7). You will notice that "Maximum mount count" is set to -1. With this parameter set to -1 or 0, the number of times my hard drive has been mounted (Mount count) is ignored. The next thing to notice is the date of the last filesystem check. In my case, it's November 28, 2016. Finally, notice that the "Check interval" is set to zero, which means there is no periodic filesystem check interval set for that particular hard drive partition.
Lucky for us, tune2fs does more than just list this information. Tune2fs also allows us to set up a regularly scheduled check of the filesystem. The method you choose to use might be entirely dependent on how you use your computer. If you are the type of person who turns their computer off every night and back on every morning, you might want to set the filesystem check frequency to be every 30 times you mount that particular partition. To do so, issue the command as tune2fs -c 30 /dev/sda6 (in my particular case) to check it every time the mount count increments to 30. If you're like me and have a computer that stays turned on 24/7, you might want to use a time based interval to determine when to perform a filesystem check. The command tune2fs -i 3m /dev/sda6 will cause a filesystem check to occur every three months, the next time the partition is mounted. A number by itself is interpreted as days (you can also use the "d" designation to denote days), while a number with "w" after it is interpreted as weeks, and "m" is interpreted as months.
fsck
The next tool is the utility called fsck, which stands for File System Consistency Check. Others refer to it simply as File System Check. It is installed by default on PCLinuxOS, so you have nothing to install from Synaptic.
Take note that fsck will ONLY check a filesystem that is currently unmounted. Attempting to run the fsck command by itself, with no parameters, will net you this response:
# fsck
fsck from util-linux 2.27.1
e2fsck 1.42.13 (17-May-2015)
/dev/sda5 is mounted.
e2fsck: Cannot continue, aborting.
So, checking the filesystem on ANY partition except the root partition is relatively easy. First, unmount the partition you want to check by issuing the umount command. So, to check the /home partition on my computer that I've been using as an example, the command will be umount /dev/sda6. Then, I can issue the fsck command like this: fsck -p /dev/sda6. Once the filesystem check has been completed, you can mount the partition again, using the command mount /dev/sda6.
The "-p" command line switch tells fsck to automatically repair any errors without asking any questions. If you want to run fsck interactively, use the -r option, instead of -p. If you want to see what's going on, use the -v option (along with the other options) to cause verbose output.
This all works great for any and all partitions, except the root partition. For all other partitions -- except root -- it's pretty easy and straightforward. But what happens when you want or need to run fsck on the root partition? Fortunately, PCLinuxOS users have two options.
The first option is to boot from a Live CD/DVD/USB and run fsck on your hard drive's root partition (/). Just enter the command as outlined here, specifying the name of your root partition (in my case, fsck -p -v /dev/sda5).
The second option is probably easier, though. From the command line, travel to the top level of the root partition (/). Then, issue the command touch forcefsck. Now, the next time you boot your computer, the filesystem on the root partition of your hard drive will be checked. After the filesystem check is completed, the forcefsck file will be deleted.
Summary
With just very little effort, you can keep the filesystems on your hard drive partitions tuned and happy for a very long time to come.
I have to admit that I was a bit shocked and surprised to discover that there are no minimal filesystem checks scheduled by default on PCLinuxOS. Even Ubuntu sets a minimal filesystem check for every 30 times a partition is mounted. But, I'm equally pleased to know that we don't have to accept not having scheduled filesystem checks. That is one thing that anyone can change with relative ease.

GOG's Gems: Realm Of The Haunting
by Agent Smith (Alessandro Ebersol)

Well, as I had written before, I would review games that GOG sells. And there is a lot of good stuff in GOG. A game that caught my eye was Realms of the Haunting.
Why is this game so special?
Well, lots of reasons… and lots of nostalgia.
Realms of the Haunting - the Game.
Forged at the beginning of the ages and protected by the seven seals, there is a place where thought and creation intertwine. The center of all the realms of existence, it is the balance of power between good and evil, man and spirit. A focal point for all energies, and the only element that has kept the consuming nature of darkness imprisoned. Until now.

The story begins in Cornwall, where the main character, Adam Randall, arrives for his father's funeral. The death of his father, going under suspicious circumstances, start a series of visions of nightmares, all revolving around a house that Adam has little memory. Haunted by those images, he eventually finds the house. He eventually discovers that it is the former home of a powerful French sorcerer, whose experiences released a horde of demons. The evil that controls the demons took Adam's father - body and soul - and is now residing in the building, waiting for next victims. Within this house is located the soulstone, an object capable of opening doors between our reality and the infernal world, giving way to the demons to the earth...
My experience
I bought this game in 1997. It was an early e-commerce venture, so I ordered this game from an American site (Funcoland, if memory serves me well), and two weeks later it arrived. A 4-CD box, with more or less, 2.7 GB of data. One annoying thing back then was to have to change the CD's during the game.
Why 4 CD's? Because of the full motion videos. The game has a whole story in FMV that plays during the player's progress. For the time the game was made (1996), it was very impressive.

Not that the video quality was excellent, since FMV at that time was in its infancy, and the compression algorithms and codecs were not that powerful (remember that at that time, 486's were powerful computers and Pentiums had just started to enter the scene).
Now, a brief review of the game.
Graphics
In that time (1996), 3D engines with 2D bitmaps were dying. Duke Nukem 3D was the culmination of this generation, which began with Wolfenstein 3D. All companies were migrating to 3D vector, like id's Quake software. But even so, the graphics are very good for what they are. I recommend adjusting the graphics for the HD version, so it will not be so pixelated.

The game is divided into the exploring parts (the game itself) and the FMV cutscenes. The cutscenes are fantastic, despite its limitations. You are compelled to play only to know what will happen to the characters (something like Ninja Gaiden, in the NES). The actors play their roles very well. There are even actors who worked in Dr. Who in this game. The costumes and sets are perfect, and there are plenty of virtual scenarios (scenes shot in blue / green screen and then placed in computer rendered scenarios).
Sound
The sound is simply fantastic. Everything has a sound in the game, from a door knob to the click of a light switch. The sound is perfect, the voices, the main character Adam (you) several times speaks alone, as we do ourselves in our daily life, giving clues of what to do in the cursed house. The sound quality is excellent, making the game immersive like never before.
You really feel you are in this house, with windows banging, whistling wind outside and all sorts of noises and creaking doors.
Gameplay
The gameplay is very good, since the game is not an ordinary FPS, but an adventure. There is a cursor on the screen, in addition to the movement keys, which changes as it passes through the screen elements. The cursor is controlled by the mouse. In some elements, like a shelf or a book, the cursor changes and takes the form of an eye, indicating that there is more to search with that item.

There is an inventory with your items and a diary where Adam takes notes, and makes observations on the events of the game. When you click on the notes, some notes are spoken (in voiceover) by Adam's character. It's a very cool effect, as if he reflected with himself about what's happening in the game.
In some situations, however, the game leaves the player a little lost, not knowing what to do and where to go. There are certain sections of the game rather complicated, like an underground labyrinth in which one has to collect a number of brains (ugh) to make a machine work, which is very disorienting.
But the immersion and the game's experience are magnificent and highly addictive. It is like a good book: once you start, you can not stop until you reach the last page. This game has that quality.
Verdict
This is an excellent game. Even though it is more than 20 years old, it is a masterpiece. Gremlin Graphics, the company that created it, would never make games like this again, preferring easy console games, which, of course, sell much faster (and have a more guaranteed return).
Gremlin Graphics was responsible for many hits, such as Top Gear (SNES), Zool (Genesis), and Jack The Nipper (ZX Spectrum). But in terms of Survivor Horror/Adventure games, they made only ROTH. There is another game made in the same engine, by Gremlin, called Normality, but it was an adventure SCI-Fi Cyberpunk game.
The verdict, of course, is BUY now. Buy now, the game is too good not to be played. Many will wonder how they did all that in 1996? Buy it even more for the price: US$ 3.49
Legacy
The ROTH game has a fan site dedicated to it, with maps, walkthroughs, tips and tricks. There are also screenshots and various downloads. The website url is: http://www.realmsofthehaunting.com
Buying Realms of The Haunting
ROTH was originally made for DOS, and runs perfectly in DOSBOX. The package sold by GOG.com on their website also features a soundtrack in MP3 and a PDF manual.
The game url is: https://www.gog.com/game/realms_of_the_haunting. You buy the game and will download an executable file with extension .sh. After the download is complete (something around 1.4 GB), give the script the execute permission (mod + x) and install the game normally. It will be installed in your /home directory.
An interesting detail is that GOG puts its own version of DOSBOX with the game. Even so, I think it would be better to use DOSBOX from the PCLinuxOS repository, and ignore GOG's DOSBOX.
For best effect, I suggest using DBGL (DOSBOX Game Launcher), which will ease the management of the game.
So I hope you have fun and unveil the mystery of the house of Cornwall.

Tip Top Tips: How I Rescued My Printer
Editor's Note: Tip Top Tips is a monthly column in The PCLinuxOS Magazine. Each month, we will feature -- and possibly even expand upon -- one tip from the PCLinuxOS forum. The magazine will not accept independent tip submissions specifically intended for inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS forum's "Tips & Tricks" section. Your tip just may be selected for publication in The PCLinuxOS Magazine.
This month's tip comes from PCLinuxOS forum member One_Beerhunter.
I have a Brother MFC J6920DW printer which doesn't get a lot of use. Recently it quit printing text. I initially suspected some update may have messed up my system, but the more I thought about it I became suspect of the print head.

This left me with few options, buy a new printer, run $100 worth of ink through the "clean cycle", purchase a print head cleaning kit online, or fake it. So with limited funds I hit the dollar store and purchased a turkey injector, one of those syringe type devices. I then took a 6" section of Cat5 cable and removed the interior wires just to obtain the jacket. Using the jacket as a tube to extend the length of the injector outlet. I could then reach the ink inlet (after removing the ink cartridge). Using isopropyl alcohol, I partially filled the injector, and holding the jacket/tubing to the inlet (not a perfect fit, I put some paper towels under the inlet), I pushed some of the alcohol into the fitting. I then withdrew the plunger on the injector to pull the softened ink from the line going from the print cartridge to the print head. I repeated this process several times, dumping the blackened contents of the injector each time, refilling with fresh alcohol. I then replaced my black ink cartridge and ran a clean cycle to flush the ink line, printed a test page twice for somewhat improved print quality. I then ran the clean cycle a second time with the same test pages, and the printer is pumping out pages like a new printer.
Hope this saves a few printers from the landfill and helps other PCLinuxOS users wondering why their printer no longer works as expected.
Forum member zerocool had this to add:
That's the problem with inkjet printers. Unless you use them very frequently (like several times a week), the ink clogs in the print head, and it can be quite a task to unclog.
The last one (inkjet printer) I got was from the junk store for $5.00. It was an HP all in one printer, scanner, copier. It worked great for years, until I switch the default printer to the laser printer. Then, after a month or two of inactivity, now it wont print. I doubt I'll try to fix it. The ink is too expensive, and I rarely find any reason to print to it anyway. It's nice to know I could fix it if I wanted to, though.
Forum member Agent Smith added this, too:
I did something like that, but with an Epson printer. Good quality, but when the printer head gets jammed, the trash bin is usually its destination. I recovered mine with a solution of hot water and a bit of mild soap, a syringe and a small rubber tube. It worked for three more years.
Editor's Tip Within A Tip: Get an inexpensive laser printer to print your documents out at home. Toner never dries up. (Brother laser printers have some of the lowest priced toner replacement cartridges, too, with Samsung coming in a close second.) If you need to print out color documents, go to an office supply store in your town. If you need to print out color photos, go to the drugstore on the corner or the big box superstore in your town. In both cases, they can print out much higher quality color documents and photos than you can at home, at a far, far less expensive cost.
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PCLinuxOS Family Member Spotlight: footstep11
As told to YouCanToo
What is your name/username?
Mauro/footstep11
How old are you?
Mid-fifties
re you married, single?
Married
How about Kids, Grandkids ?
Two 'kids': one is almost 25 and the second is 19.
Do you have pets, what is your favorite?
No animals, even if the kids repeatedly asked for them (we live in a condo and we are away for work all day long ... not the best situation for an interacting animal ... maybe right for a fish).
Are you retired, still working and if working, what do you do?
I am a high energy astrophysicist, and my main area of interest is the study of celestial sources as observed in X-rays. I specialize in compact galactic sources, like neutron stars and black holes. I also teach at the university, and do public presentations for the general audience.
Where do you call home? What is it like? IE: weather, scenery
I live in a medieval Italian town called Ferrara, and commute every day to the nearby Bologna. Ferrara is a very quiet town, mid-sized (130,000 inhabitants), surrounded by fortified walls, upon which people can walk and jog. Everyone moves by bike in Ferrara. There are more bikes than inhabitants! Ferrara hosts the oldest palio race in the world (the first edition is dated 1259). At the and of May, more than 2,000 people fill the streets in their medieval costumes and armors. Then there are four races: two on foot, one on donkeys, and one on horses, mounted bareback.

Bareback horse racing

The Donkey Race

Historical reenactment.

Basilica Cattedrale di San Giorgio, Duomo di Ferrara (Ferrara Cathedral) - Constructed in the 12th Century, The cathedral stands in the city centre, not far from the Palazzo Comunale and the famous Castello Estense.

Bell tower of the Cathedral of Ferrara - Made from pink and white marble, it was built between 1451 and 1493, and although further work was done in the sixteenth century, it remains an unfinished piece.
Where did you go to school and what is your education level?
I got my physics degree at my local university. Ferrara is among one of the oldest universities in the world (Copernicus got his degree there). Then, I got my PhD in Astronomy at the International School for Advanced Studies in Trieste in 1990. Soon after, I got a two-year post-doc position in Greenbelt, MD for working on a x-ray satellite called Rossi-XTE at the NASA/Goddard Space Flight Center. After that, I was called back in Italy to work on an Italian X-ray satellite called BeppoSAX. Since then, I was involved in many other projects involving X-ray astrophysics. Now I am a senior researcher at the Italian National Institute for Astrophysics in Bologna.
What kind of things you like doing? hobbies, travel, fishing, camping?
I have always liked sports. Football (or, as the American call it, soccer) and motorsports, Ferrari and Valentino Rossi above all. I am an active runner (I run the 10k every week), and like to go to the gym twice a week, doing fit & boxe (you punch and kick a punching bag: VERY good for relieving stress!). I like listening to music, classical and jazz in particular, and going to concerts, when possible. I read a lot, at least a book per month (commuting by train, I have at least one hour per day for reading). I like very much fantasy: Terry Brooks, David Eddings, George R.R. Martin, and of course J.R.R Tolkien, are my favorites.
Finally, I like very much watching TV series. Marvel's heroes are my favorite (I think the first season of Dare Devil is absolutely PERFECT), but I do not dislike comedies, like 'The Big Bang Theory', or thrillers like the NCIS saga.
Why and when did you start using Linux?
Because of my work, I have always been involved with computers. I started back in the mid '80s with a DEC PDP11 (I did not use the punching cards because my university just bought a magnetic tape unit... wheee). I have worked with DEC computers (with VMS as operative system) until 1994, when my institute bought a DEC AlphaStation running ULTRIX, the DEC variant of UNIX. These computers were VERY expensive (the price of a mid-class automobile), but were indestructible. I did not switch off or reboot my machine for more that five (yes, you read it right: five years!). I started learning shell scripting and programming (mainly FORTRAN and interpreted languages, like perl).
At the end of 1994, I set up the institute web server. You had to compile the httpd daemon from source, and also compile the web browser. It was called mosaic. Then, in 1996 I installed RedHat 4.0 on my PC. It was really a pain. You had to compile a lot of programs from source, but at the end, you had a working system (not enough for my work, but enough for doing some experiments).
Then in 1998 Mandrake came out, and I immediately liked it, especially for its fantastic system of hardware recognition. I kept with Mandrake (that become Mandriva in 2005) until 2013, when Mandriva terminated (meanwhile my DEC AlphaStation died, and I passed to a personal computer running Linux also at work). I was looking for an alternative as good as Mandriva, and I found PCLinuxOS. It was love at first sight. Since then, I am a devoted Texstar follower.
What specific equipment do currently use with PCLinuxOS?
All my machines run PCLinuxOS: a desktop at work, my laptop and desktop at home (even if my family still prefers to use Windows).
What would you like to see happen within PCLinuxOS that would make it a better place. What are your feelings?
I think that the real added value of PCLinuxOS is its community, and its forum. If you have any computer problem (but not only that, in the sandbox section you can discuss about anything, in the limit of decency, of course), then ask in the forum. Even if you are a newbie, you will find people that will answer you, or address you to the right solution, if possible/available (see, for example, the posts by Old-Polack).
I am always been convinced that knowledge must be shared, and Linux is the perfect example of it. If everyone shared what she/he knows, and is open to learn from others, then everyone will gain from the exchange. Our forum is the perfect example of this concept.
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring a PCLinuxOS forum member. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.
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